
PCI Express Test Build.
There follows a description of the build to run the PCI express interface on the Raggedstone2 board.
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Design Structure.
The project starts by generating a PCI Express core. With this core, a Xilinx design example is 
automatically created, which when run, adds a PIO core to the PCI Express core as an Endpoint.
This project adds in addition to the PIO an IO controller, connected between the PIO and the PC 
interface.
The input to the PC interface is a GUI and this allows two of the Raggedstone2 LEDS to be toggled.
As the downloaded files were in Verilog , this has been the coding language used for this project.

PCI Express Input and Outputs with IO Controller input and outputs.



Top Level xilinx_pcie_1_1_ep_s6. 
IO controller inputs/outputs DIP, PUSH_USER, LED_COUNT0 and LED_USER have to be added.

Raggedstone2 PCI Express Test Procedure.
This test uses the driver, GUI and part of the test code downloaded from the AVNET site.

Obtaining the code, driver and GUI.
The link to the Avnet site is:
http://www.em.avnet.com/evk/home/0,4534,CID%3D57572%26CCD%3DUSA%26SID
%3D32214%26DID%3DDF2%26LID%3D32232%26BID%3DDF2%26CTP%3DEVK,00.html?
SUL=spartan6lx150t-dev

Go to Support Files and Downloads.
Before clicking on this, a new account has to be created.
Then download S6LX150T Development Board PCIe Example Design.
The downloaded code is unzipped to s6lx150t_pcie_design_edk11_4
This contains the code, driver and GUI. 

Project Files and Location.

The files used in this project include:

Procedure for Building the Design.
We start by creating a new project rs2_pcie.
File>New Project

http://www.em.avnet.com/evk/home/0,4534,CID%3D57572%26CCD%3DUSA%26SID%3D32214%26DID%3DDF2%26LID%3D32232%26BID%3DDF2%26CTP%3DEVK,00.html?SUL=spartan6lx150t-dev
http://www.em.avnet.com/evk/home/0,4534,CID%3D57572%26CCD%3DUSA%26SID%3D32214%26DID%3DDF2%26LID%3D32232%26BID%3DDF2%26CTP%3DEVK,00.html?SUL=spartan6lx150t-dev
http://www.em.avnet.com/evk/home/0,4534,CID%3D57572%26CCD%3DUSA%26SID%3D32214%26DID%3DDF2%26LID%3D32232%26BID%3DDF2%26CTP%3DEVK,00.html?SUL=spartan6lx150t-dev


New Project rs2_pcie and folder location.

We then create our PCI Express core. 
Project>New Source
This generates the core page windows. We name the component s6_pcie.

Page 1: Component name and Device type.
Click on and the next for the next window.

 Page 2: BAR0 should be not selected. BAR1 to BAR5 should be deselected.



Page 3: The ID and Class Codes should be as above.

Page 4-8 should be left as default values.

Page 9 should have the reference clock set at 100MHz.
Following this we click on Generate.

From the Design Hierarchy s6_pcie.xco has been generated.

IPCORE Generated files
Generating the core creates new folders for the ipcore and also the example design.
Example design  folder.

Example_design folder auto generated files.



Source folder auto generated files.

We copy  xilinx_pcie_1_1_ep_s6.v to the V folder and also bar0_io_devices.v and 
bar0_io_devices.v files.

Running the example design.
We can now run the example design by loading the example project in 
the ipcore folder.

File location of s6_pcie_verilog_example_project.xise

We execute this file and load the design example.



File structure having run s6_pcie_verilog_example_project.xise.

Synthesizing the design example.
Once the design example has been run, it should be synthesized to 
make sure all is correct before moving on to editing the code.

Modifying the design to include the IO controller.
The IO Controller has inputs at the top level down through to the 
PIO. At the PIO level we instantiate bar registers, which read 
these inputs from the toplevel (DIP and PUSH_USER) and then output 
to the top level(LED_USER and LED_COUNT).

LED_COUNT[3:0] and LED_USER instantiated at each level from 
bar0_io_devices to toplevel.

The inputs and outputs that connect to the GUI are as follows:

Code Edits.
The following files need to be edited to allow the PCIE to be 
tested using the GUI interface with the io controller placed at the 
PIO level.



File: xilinx_pcie_1_1_ep_s6.v. 
Add input outputs to top module xilinx_pcie_1_1_ep_s6 and 
instantiate those inputs/outputs in pcie_app_s6.

File: pcie_app_s6.v edits. 
Add input outputs to pcie_app_s6 and 
instantiate those inputs/outputs in PIO

module xilinx_pcie_1_1_ep_s6
(

 output          LED_USER,
    output [3:0]    LED_COUNT,

input DIP[3:0],
input PUSH_USER[1:0]
);

pcie_app_s6 app // 
instantiation.

(
 .LED_USER(LED_USER),

.LED_COUNT(LED_COUNT),
    .DIP(DIP),        
    .PUSH_USER(PUSH_USER)

);

module pcie_app_s6
(

  output          LED_USER,
    output [3:0]    LED_COUNT,

input DIP[3:0],
input PUSH_USER[1:0]

);

PIO PIO // instantiation.
(

 .LED_USER(LED_USER),
.LED_COUNT(LED_COUNT),

    .DIP(DIP),        
    .PUSH_USER(PUSH_USER)

);



File: PIO.v. 
Add input/outputs to PIO and 
instantiate those inputs/outputs in PIO_EP.

File: PIO_EP.v. Instantiate in module PIO_EP the input and outputs.
 

File: PIO_EP.v. Instantiate the bar0_registers.

module PIO
(

  output          LED_USER,
    output [3:0]    LED_COUNT,

input DIP[3:0],
input PUSH_USER[1:0]

);

PIO_EP PIO_EP // instantiation.
(

 .LED_USER(LED_USER),
.LED_COUNT(LED_COUNT),

    .DIP(DIP),        
    .PUSH_USER(PUSH_USER)

);



File: PIO_EP.v. Instantiate the bar0_io_devices.

File: PIO_EP.v, comment out PIO_EP_MEM_ACCESS

Reset.
The PCI Express reset is not connected to the interface so this is 
hardwired to 1.

File: xilinx_pcie_1_1_ep_s6.v Top level instantiation of s6_pcie, 



reset = 1'b1.

Synthesizing the Modifyed Design.
Double click on Synthesize – XST and remove all errors.

Implementing the design.
Double click on Implement.
All boxes should be ticked.

Implemention: A good result.

Generate Programming File.
We double click on Generate Programming File and this creates 
xilinx_pcie_1_1_ep_s6.bit (toplevel name.bit).
This file is located in the work directory.

Project>Design Properties

The working directory is the ipcore folder and the .bit file will 
be found here.

Configure Target Device running Impact.
Double click on the Configure Target Device.
This runs Impact.
From the IMPACT window and with the Raggedstone2 board connected 
for programming we double click on Boundary Scan.

Boundary scan clicked on.



Click on the initialize chain symbol.

Initialize chain symbol

Succeeded connection to the Raggedstone2 board.

We then click on the Create Prom File Formatter.
This generates the window below. We follow the steps for an SPI 
Flash, a Configure Single FPGA, a device of 128M. Add Storage once 
selected.
We locate the folder for the .mcs file, generated on the next 
stage.

PROM file formatter. Single FPGA, Storage Device 128M, location 
work directory, output file name myprom.

When OK is pressed, we are told to select the file. 
It should be in the work folder and check that the modified time is 
correct.



Add Device: top level .bit file from Generate File.

Select this file.

Next we click on Generate File to create the programming myprom.mcs 
file.

Generate File: succeeded and shows the folder for the myprom.mcs 
file.

Now to load myprom.mcs file.
Click on the Boundary Scan Tab.
Note: If this is not evident, Impact might have to be run again.



Identify succeeded. 

We are now ready to program the prom.
Right click on the light blue box above the FPGA.
>Add SPI Flash.
This takes us to myprom.mcs file in the work folder.
Check that the modified time is correct.

Myprom.mcs programming file for the Raggedstone2 board.

When we click OK to this, another window appears. 
We select the SPI PROM. Select M25P128.



Selection of the PROM type.

Flash inserted.

We now program the flash. Right click the FLASH and select Program.
The flash will program to 15% and should succeed.
This takes about 4minutes.



Inserting ChipScope.
To test that the GUI is doing what it says and that the 
Raggedstone2 PCI Express is working correctly , we insert ChipScope 
to look at the signals.

First we have to generate the ChipScope Cores ChipScope_icon and 
ChipScope_ila.

Run the Core Generator.

Once running, create a new project. This is saved in a new folder 
MACROS.

MACROS folder for ChipScope macros.

Another window appears for project options.

PART project options.

Click on Generation and select Verilog for Design Entry.
Click OK to the window.



From the Xilinx Core Generator list, select ICON and double click 
on this.

Selecting ICON from the core generator.

To test the PCI Express we will be using the PCI clock trn_clk.

One control signals selected. 

>Generate
Next we double click on ILA from the core generator.
We want one trigger port.



Page 1:One Trigger port 

>Next
We want a trigger of 128 bits.

Page 2: Trigger Width changed to 128

>Generate.
We now have the cores for ChipScope. They just need instantiating 
in the code and signals assigned that we want to see, that is for 
loopback test and PCI Express test.

Back to the code.
We instantiate the ChipScope cores in the top level.



Instantiation of the ChipScope core.

We then assign the signals we want to see.

For the PCIE we need to look at the main signals for TLPs, that is 
received and transmitted data, start, end and frame ready signals.
PCIE ChipScope signals.



Having edited the toplevel file we are ready to run Synthesis 
again.
We now have to load ChipScope_icon.v and ChipScope_ila.v into the 
design.

Loading ChipScope.v files.
We also have to tell implement where to find the macros.
Right click on Implement and locate the MACROS folder from the 
Macros Search Path.

Locating the ChipScope MACROS folder.



Once done, the design should successfully build with ChipScope.

User Constraints File.
The UCF file has been generated from the design example.
We retain those constraints and add others which affect the IO 
Controller inputs and outputs.

Clock and IO constraints.

Testing the Build. 
Having built the project successfully we are ready to plug in the 
Raggedstone2 board and check that it has been recognised by the PC 
device manager. We can then install the driver and run the GUI and 
use ChipScope to see the movement of packets.

Pre installed  Raggedstone2.
If we are downloading to the Raggedstone2 board already installed in the PC, then once the code is 
downloaded we turn off the PC. Resetting the PC doesn't always work as the reset input to the 
Raggedstone2 isn't connected via the PC.
 



Installing the  Raggedstone2.
Turn off PC.
Remove the Raggenstone2 on-board oscillator and all loop-back test connectors.
Place jumper J4 to the PC connector position.
Insert board with USB cable attached.
Turn on PC.

Check Installation has worked.
To check that the Raggedstone2 board has been installed correctly, we can:
      1) Check that the Device Manager and check the ID.

2) Run PCI32 and search for our processor.

Running with the Device Manager.
On an XP machine:

Start>Settings>Control Panel>System.
Hardware Tab>Device Manager.

There will be displayed  a list of devices.

If we right-click on Coprocessor> Properties>Details and select  Device Instance from the tab,
we can see the vendor and device name, as set up in the PCIE core.

Running PCI32.
This test program explores all PCI devices and downloads the information as a text file.
The link is to Craig's PCI programs.
http://members.net-tech.com.au/dft0802/downloads.htm

Having run PCI32 we have get the following information form the pcie.txt file.

Note that this lists all the information typed in when creating the PCIe core.

 
 Bus 4 (PCI Express), Device Number 0, Device Function 0
 Vendor 1597h Memec Design Services
 Device 0301h Unknown
 Command 0007h (I/O Access, Memory Access, BusMaster)
 Status 0010h (Has Capabilities List, Fast Timing)
 Revision 00h, Header Type 00h, Bus Latency Timer 00h
 Self test 00h (Self test not supported)
 Cache line size 32 Bytes (8 DWords)
 PCI Class Processor, type Coprocessor
 

http://members.net-tech.com.au/dft0802/downloads.htm


This file also contains a lot more information. 

Installing the Driver.

Right click Coprocessor.
>Update Driver
Windows now appear.

Window 1: 
Qn:Can windows connect Windows Update to search for software?
Ans:No, not this time

Window 2: 
Qn:What do you want wizard to do?
Ans: Install from a list or specific location

Window 3:
Qn: Search installation location?
Ans:Don't search, I will chose the driver to install.

Window 4:
Qn:select Drive driver?
Ans: Have Disk

Window 5:
Qn:Locate file?
Ans:oemsetupXP.inf

The .CAB file might need unzipping.

We click  next and windows queries that the driver hasn't been tested or signed.
This is okay and we continue anyway.

The driver is installed.

To check it's working properly:
Right-click on the driver in the device manager
Click on Properties.
Windows tells us that the device is working properly.



Testing the PCI Express.

We run Spartan3-1000_Basic_Demo.CAB/pcie_io.exe

This runs the GUI.



GUI working buttons.

The GUI only affects LED5 and LED4 on  Raggedstone2.
CYCLE is not available.
GUI User LED will toggle Raggedstone2  LED4.
GUI ALL On and All Off buttons affect Raggedstone2 LED5.
Count will turn Raggedstone2  LED5 on and off at a ½ second frequency.

Further Tests.
A connector can also be placed across the inputs to 3v3 to see the User and DIP switch buttons turn 
on and off. The far right connector Y17 is the easier to access and will show USR1 switch.
USR1 = Y21
USR2 = W20
DIP[3]=AB15
DIP[2]=Y15
DIP[1]= AB17
DIP[0]=Y17

Raggedstone2 PCI Express test using ChipScope.
With the above GUI, we can use the LEDS as a trigger to catch our PCI express packet or 
Transaction Layer Packet.

Run the ChipScope Analyser.
We have to rename signals from DataPort to the actual signal name as defined in the top level 
module. Once done, save the project (name.cpj) and the signal names can be reloaded every time 
ChipScope is run.

Next, to set the trigger window, open out the trigger port, go down to port 87 led user.
This is the led user input from the GUI. This should be set to 0.
We also set the Position to 128 out of 1024

87 led user set to 0.

position of trigger set to 128.

Press the trigger triangle and ChipScope will wait for Led User to be switched.



Trigger triangle.

Go to the GUI and press Led User.
The captured screen should look  like the diagram below.

Led User going low.

The Led User can be seen going low and the received data with a start and end of frame. 
If we open out the second frame at position 172, this shows the trn_rd (received data) with a start of 
frame 

trn_rd Received data
trn_td Transmitted data
trn_rsof_n Receive start of frame
trn_reof_n Receive end of frame.
trn_rsrc_rdy_n Receive source ready.

We can zoom in and open out trn_td and note that whenever: 
GUI User Led is pressed off (Raggedstone2 LED4 off), trn_td[24] = 1.



GUI User Led is pressed on (Raggedstone2 LED4 on), trn_td[24] = 0.    
 


